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1 The radio sky

When we look up into the sky on a clear, cold night, our eyes can see a bright band
stretching across the sky. If you observe it with a pair of binoculars or a small
telescope like Galileo 1609, you will notice that this band consists of a myriad of
stars. It is the Milky Way, our own galaxy, which we see from Earth in this way,
containing about a hundred billion stars, of which our Sun is just one among many,
and there are many others in the Universe galaxies.

Astronomers took a long time to figure out what our galaxy really looks like. It
would be so much easier if one could get into a spaceship and simply look at it
from the outside. Unfortunately, traveling in and around the Milky Way is because
of the enormous distances that have to be set aside for it. On the other hand,
observing the Galaxy from within the Solar system is complicated by the fact that
some regions of the Milky Way appear darker than others they are obscured by
large amounts of interstellar dust, these dark clouds obscure many stars.

Observations of external galaxies, both with optical and radio telescopes, have
helped to clarify the structure of the Milky Way. Today, astronomers assume that
they know exactly how stars and gas are distributed within it: our galaxy is a
thin disk of stars and gas arranged in a spiral, with a larger bulge at the centre,
which hosts also a supermassive black hole with mass of about three million times
the mass of the Sun. The central black hole is also a strong radio source named
Sagittarius A*.

In the thirties of the twentieth century, another mystery arose around the Milky
Way, so called dark matter. The largest part of the mass of our galaxy seems to
be invisible, and only reveals itself through gravitational interaction. Imagine a
fast-dancing couple in a dark room. The man is completely dressed in black, the
woman is wearing a fluorescent dress, the man is invisible, so to speak, but the
movement of the woman makes it possible to conclude his presence: someone has
to hold on to her, otherwise she would not be able to keep spinning. Likewise, in
our Galaxy, the stars and the gas are spinning too fast to be held by gravity of
observable mass, so additional massive matter must be present, but remain invisible
to the human eye and all instruments built so far. This substance of yet unclear
origin is called “dark matter” and is only observed indirectly.
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One of the most important indication of the existence of dark matter is the
measured velocities of visible matter in the outer regions of the Milky Way, and
Radio observations of the kind you will do during the current lab-work have played
an important role in the discovery of dark matter. In this experiment we will take
a radio look at the closest star, the Sun, and the closest Galaxy, the Milky way, in
order to get a first glimpse on methods and instruments specific to radio astronomy,
and what we can learn from it.

1.1 A bit of history

The history of radio astronomy is closely tied with the history of physics in general.
The breakthrough in understanding of electromagnetic phenomena associated with
works of James Clerk Maxwell in 1960s, immidiately prompted physicists and
astronomers to conclude that there must be sources of radio emission in the sky.
Several unsuccessfull attempts were made to detect thermal radio emission from
the Sun including experiments by Johannes Wilsing and Julius Scheiner (Germany)
in 1896 and by Oliver Lodge soon after that. The technical limitations at the time
made such detections extremely challenging and were the true reason for failure,
although the discovery of the radio reflecting ionosphere in 1902 led physicists to
conclude that the layer would bounce any astronomical radio transmission back
into space, making them undetectable from Earth. Which, as we now know, and
will verify in the current lab work, is not fully true.

The actual radio astronomy begun with the work of American physicist and radio
engineer Karl Jansky, who was hired by his employer, Bell Laboratories of Holmdel,
New Jersey, to locate the origin of the transatlantic radio telephony interference.
To this end, he built a large, rotatable and vertically polarised directional antenna,
which could observe at a frequency of ∼ 20.5MHz, and began his observations in
1930. In 1932, he published his first results. In addition to local and more distant
thunderstorms, he had identified a third source of interference, a very uniform
noise of unknown origin, and in the following year he succeeded in proving that
the source of this radiation was outside the Earth. Through close observation
and comparison with star maps, Jansky concluded that the Milky Way, and in
particular its centre, was the source of these radio waves, however, Jansky was not
able to continue his work at the time due to lack of support from Bell Labs.

Several years later, American amateur astronomer Grote Reber picked up on Jan-
sky’s discoveries and built the first radio telescope dedicated to purely astronomical
purposes in his garden in 1937. It was a nine-meter parabolic antenna that was
swivelling but not rotatable. In 1938 he was able to verify Jansky’s observation
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and in 1940 was the first to publish a radio astronomical work in an astronomical
journal. In 1941 he began to create a map of the starry sky in the radio band. He
discovered several strong radio sources, including Cygnus X−1 and Cassiopeia A.
In addition, he found that the sun is a radio source whose intensity follows the
11-year rhythm of solar activity. Jansky had been observing during the period of
minimum activity, which precluded him from detection of the sun as a radio source.
Another important discovery of Reber’s was that the radiation emitted from the
center of the Galaxy did not follow Planck’s law, but rather a power law. The
explanation for this is found only in the 1950s when it was recognized that cosmic
radio emission most often has non-thermal origin.

Radio astronomy experienced a boom after World War II, as many formerly military
(radar) facilities could be used for astronomical purposes. The first detection of
the Sun came somewhat later, on February 27, 1942, was also associated with
that boom. James Stanley Hey, a British Army research officer, made the first
detection of radio waves emitted by the Sun using military equipement. Later that
year George Clark Southworth, at Bell Labs like Jansky, also detected radiowaves
from the sun. Both groups were bound by wartime security surrounding radar, so
were actually not the first to publish the results in due time, which allowed several
people (including Reber mentioned avove) to independently discover our star in
radio band.

Nobel Prize winner Martin Ryle’s group also used two formerly military antennas as
interferometers. In 1944, Hendrik van de Hulst suggested that atomeric hydrogen
in interstellar space could produce line emission in the radio band, a theory that
was proved in 1951 by Harold Ewen and Edward Purcell by observing the 21 cm
hydrogen line.

In 1967, the then doctoral student Jocelyn Bell discovered the first pulsar, for which
her doctoral supervisor received the Nobel Prize in 1974. The reason was that this
discovery proved for the first time existence of extremely dense compact objects,
neutron stars, first predicted by Landau based on fundamental physics grounds,
and basically cemented achievements of particle physics of the 20th century.

As previously suggested by Grote Reber, the system consisting of the antenna
and the receiver from which each radio telescope is made, performs a bolometric
measurement, i.e. determines the temperature of a source. This is what Arno
Penzias and Robert Wilson used in 1965 in their attempt to measure the temperature
of absolutely cold space, by comparing the radio signal detected from the sky with
that coming from within a cooled cavity on ground. This work led to the discovery
of the 3 K cosmic microwave background radiation, which, directly or indirectly,
eventually was worth several nobel prizes.
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The radio astronomy made great strides ever since its birth, discovering thousands
of sources of all kinds, and becoming an essential observational window for modern
astrophysics. Of course, this success is largely attributed to developement of
modern instrumentation, i.e. radio telescopes and interferometers. These are
among most impressive constructions devoted to studies of the sky, and the largest
can be hudgred of meters or even larger. The Five-hundred-meter Aperture
Spherical radio Telescope (FAST)) is the largest single-dish radio telescope located
in southwest China, and, as the name suggests has a diameter of half a kilometer.
Radio interferometers uniting many telescopes can be even larger. The space-based
radio interferometer project, Radioastron, for instance, allowed to have an effective
antenna size comparable to that of the moon’s orbit. In current experiment,
however, you will move back in time, to when the radio telescopes were small and
had comparatively low sensitivity. Still, you will be able to give your first look to
the radio sky and observe the Sun, and our own Galaxy, the Milky Way.

Exercise: What kind of radiation is emitted by the galactic center in the form of
radio waves and what is its origin? What’s the origin of radio emission from the
Sun?

1.2 The Sun

Only a handful of radio sources are accessible to small telescopes. In current lab
work we will observe the Brightest discrete Radio source in the Sky, the Sun. Unlike
the Galactic hydrogen, the Sun emits mostly continuum thermal radio emission,
which has i.e. same origin as the optical light we can se with our own eyes. However,
considering that the radio band corresponds to lower temperatures, this emission
is produced in cooler parts of the sun, in the chromosphere and in the corona
(the solar atmosphere) rather than photosphere observed in the optical band. A
radio image of the Sun as observed with high-resolution radio telescope is shown in
Fig. 1.1, where one can also see active regions associated with the magnetic activity
of our star. These regions have somewhat different radio spectrum compared to
rest of the surface, and are variable on a timescale of days to months. This variable
component is most prominent at longer wavelengths and is observable with our
telescope.

Unfortunately, the spatial resolution of Tübingen radio telescope is not sufficient
to see the Sun as extended source, so the goal of our observations will be just to
detect it as a point source, and use it to measure the angular resolution, or beam
size, of our instrument. Keep in mind that it is still not a small achievement, and
only happened for the first time less than a hundred years ago!

6



Figure 1.1: The radio Sun: radio image of the Sun recorded by very large array
(VLA) radio interferometer. The brightest regions are part of corona
nearby but beyond sunspots (left), and the spectral energy distribution
of the Sun (Right). Images courtesy (NRAO/AUI)

Exercise: Calculate the expected angular resolution of 2.3 m radio telescope
operating at GHz frequencies and compare it with the angular size of the Sun. Is
the assumption mentioned above justified?

1.3 The Milky Way

Location of all celestial objects can be specified in a number of ways or, equivalently,
“coordinate systems”. Considering that most astronomical objects are very far away,
it is often sufficient to specify their location on the celestial sphere, which is
typically done by definition of two angles, much like the longitude and lattitude
for coordinates on Earth. Of course, this is only true when we are not interested
or can not recover the three-dimensional relation between individual objects and
Earth! The choice of a reference point from where the two angles are measured
depends on a particular problem one faces, i.e. serves our own convinience. Some
commonly used coordinate systems, also useful in context of our experiment include
Alt-azimuthal, Equatorial, Ecliptic, and Galactic coordinates. The Alt-azimuthal
coordinate system is connected to a given point on Earth’s surface, and location of
the celestial objects is defined by their altitude above the horizon (or displacement
from Zenith), and their Azimuth, i.e. angle between the direction to the object and
Earth’s north pole. The problem here is of course, rotation of the Earth, which
makes all coordinates time-dependent. To overcome this issue, several coordinate

7



systems tied to the sky itself rather than Earth have been introduced.

In Equatorial coordinates the plane of the horizon is substituted with Earth’s
equatorial plane, and the direction to the north with the angle between March
equinox point (intersetion of equatorial and Ecliptic planes), and the object. This
angle is called “right ascention” or α, and can be measured either in degrees or
time units (remember, the Earth rotates, so angle between the equinox and an
object can be measured also as difference of their rise times, i.e. from 0 to 24 h).
The second angle is measured from the celestial equator, and is called declination
δ, and is usually measured in degrees (from -90◦ to 90◦). Coordinates of a given
star in this coordinate system remain constant (ignoring precession of Earth), and
thus are suitable to specify position of objects in catalogues. Moreover, rotation
only changes right ascention, so this coordinate system is particularly suitable for
tracking objects in the sky as the Earth rotates. This is by far the most often used
coordinate system, and will be used during the experiment to point the telescope to
and track the Sun in the sky. Ecliptic coordinate system is similar, but uses ecliptic
plane (i.e. projection of the solar system equatorial plane on the celestial sphere),
and is more suitable for specifications of the positions of solar system objects. In
fact, this would be your coordinate system of choice for Sun observations if our
telescope supported! (why?).

Finally, the Galactic coordinate system uses the Galactic equator as fundamental
plane, and is useful to understand where a given star is located within the Galaxy.
Here the relevant angles are the Galactic latitude b (measured from the Galactic
plane), and the Galactic longitude l measured from the Galactic centre. The
relation between different coordinate systems is illustrated in Fig. 1.2.

The Sun is located in the “outer" regions of the Galaxy, approximately 8.5 kpc
(or ∼ 25000 light-years) away from the Galactic center. Similarly to most stars
and gas, the Sun resides in a thin disc and orbits around the common centre of
mass with orbital period of about 240 million years. The Sun thus moves with
∼ 220 km/s. As already mentioned, to describe the position of a star or a gas cloud
in the Galaxy, the use of the galactic coordinates (l, b) is appropriate. l is the
galactic longitude, and measures the angular distance of an object eastward along
the galactic equator from the galactic center. b is the galactic lattitude (Fig. 1.3),
and thus measures the angle of an object north or south of the galactic equator
(or Galactic plane) as viewed from Earth. In this coordinate system the Galactic
center has coordinates (0, 0).

For further orientation, the Galaxy is divided into four quadrants, which (unlike in
Star Trek) are denoted by Roman numerals (Fig. 1.4):
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Figure 1.2: Reference planes of commonly used celestial coordinate systems. The
Alt-azimuthal coordinate system also uses two angles, but is connected
to point on Earth and thus is not shown.

Figure 1.3: The galactic coordinate system with the coordinates l and b. C denotes
the center of the Galaxy, S the position of the Sun.
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Figure 1.4: Schematic representation of the spiral arm structure of the Galaxy. C
is again the center of the galaxy, the location of each arm is indicated.
In addition, the division into quadrants is outlined.

Quadrant I: 0° < l < 90°
Quadrant II: 90° < l < 180°
Quadrant III: 180° < l < 270°
Quadrant IV: 270° < l < 360°

The quadrants II and III mainly contain matter in orbits around the galactic center
with a radius greater than that of the Sun. Quadrants I and IV mostly cover the
inner parts of the Milky Way.

A few more quantities are useful for description of the Galaxy and movement of its
components during your work on the experiment (Fig. 1.5):
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Figure 1.5: Explanation of the magnitudes used C denotes the galactic centre, S
the position of the sun and M the position of a gas cloud.

V0 The speed with which the sun moves around the galactic centre
(220 km s−1)

R0 Distance of the sun from the centre of the galaxy(8,5 kpc)
V Speed of a gas cloud
R Distance of a gas cloud to the Galactic centre
r Distance of a gas cloud to the Sun

Exercise: Why do the two coordinates l and b suffice to describe the (three-
dimensional) Milky Way? Is it always the case?

1.4 The search for hydrogen

The largest part of the gas in the Milky Way is neutral hydrogen (H). H i is the
simplest of all atoms: it consists of a proton and an electron. Atomic hydrogen emits
a line with a wavelength of λ = 21 centi meter, which is thus a radio line. This is
the signal we want to observe! The corresponding frequency can be calculated as

λ = 21 cm ⇒ f = c/λ = 1420 MHz (1.1)
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Figure 1.6: Schematic representation of the hyperfine structure transition of neutral
hydrogen from F = 1 to F = 0 Source: Wikimedia Commons, in the
public domain

The 21 cm line is associated with the hyper-fine structure transition in neutral
hydrogen, the energy released when the spin of the electron jumps from antiparallel
to the nuclear spin parallel to the nuclear spin (“spin-flip”), ∼ 5.9 × 10−6 eV, which
is another way to say 21 cm. The probability for this transition is very small
(approximately once every 10 million years per atom), however, the large amount
of neutral hydrogen in the Milky Way makes it one of the most prominent features
in radio sky.

Exercise: what kind of observable signal does neutral hydrogen produce? Why is
it easy to observe? Can you think of other tracers which can be used for similar
purposes?
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2 Theory basics

2.1 The Sun

Sun is the brightest discrete object in radio Sky, and is observed as a point source
with our small telescope. Indeed, difraction-limited angular resolution, or beam
width of a telescope in radians is given by ∼ λ/D where λ ∼ 20 cm is the wavelength
of the observed emission (in GHz band), and D = 2.3 m is the characteristic size
of the antenna. This implies beam width of ∼ 5◦, i.e. by factor of 10 larger than
angular diameter of the Sun. One can verify this conclusion directly by pointing
the telescope at slightly offset angle with respect to the position of the Sun, and
measuring the respective intensity. Alternatively, one can use this approach to
locate objects in the Sky. To do that, one can scan the sky by moving the telescope
axis around and measuring the intensity. In this way a radio map of the sky can
be obtained, which is, in fact, how most of the currently operating radio telescopes
work.

In our experiment we will do both using the observations of the Sun (assuming that
it is a point source). In particular, the goal of the excercise is to scan over (known)
position of the Sun in two perpendicular directions, and measure the observed
intensity as function of respective coordinate. The observed intensity will obviously
be maximal when pointing directly at the sun and lower as the angle between
it and the pointing direction of the telescope increases as illustrated in Fig. 4.2.
Considering that the sky and the sun constantly move due to the rotation of the
Earth, for this experiment it is convinient to use the equatorial coordinate system,
and scan along the right assention and declination by adjusting one coordinate at
a time. As a result, two curves similar to that in Fig. 4.2 will be obtained, which
can be used to determine the position of the Sun (i.e. its coordinates), and width
of the telescope beam. To do that, one needs simply fit the observed lightcurve
with a gaussian function (plus some constant to account for astrophysical and
instrumental background)

Exercise: Why equatorial coordinate system is preferred for this excercise? How
many points would you need to accomplish the excercise (for a single scan)? What
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s = cTs' = vT

Figure 2.1: Illustration of the Doppler effect. Source: Wikimedia Commons,
Bartek444, GFDL / CC-BY-SA-3.0, modified

would be corresponding step size expressed in degrees, and hours, minutes, seconds
(for right assention)?.

2.2 The Doppler effect

By observing the 21 cm hydrogen line, we can learn a lot about the movement of
gas in our galaxy. In particular, thanks to the Doppler effect, named after the
Austrian physicist Christian Johann Doppler (1803-1853), we can directly measure
velocity of the gas.

For the derivation we consider Fig. 2.1. The source of the radiation, in this case a
star, emits electromagnetic waves with the period T . In the time T the radiation
moves with the speed of light c by the distance s = c T to the observer (left in the
figure). At the same time, the source moves at speed v relative to the observer by
the distance s′ = v T . Here, v > 0 f for a moving object (redshift) and v < 0 f for
an approaching object (blue shift), so for a complete period, the wavelength will
be

λ = s + s′ = c T + v T . (2.1)
The wavelength for emission from a stationary source is

λ0 = c T . (2.2)

The movement of the source thus leads to a change in the wavelength

∆λ = λ − λ0 = c T + v T − c T = v T (2.3)
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Figure 2.2: The speed of the cloud is projected onto the line of sight.

or relative change
∆λ

λ0
= v

c
. (2.4)

This only applies to v llc. The result is > 0 for a redshift. Converted into
frequencies, the relationship is

∆f

f
= −v

c
. (2.5)

In this notation, the result is < 0 f for a redshift.

Rotation of the Galactic disc implies that there is always some movement of its
components with respect to each other, so frequency of emitted 21 cm line at Earth
will deviate from 1420MHz. Measuring this deviation allows us thus to map velocity
of the gas clouds and thus the rotation of the Milky way as a whole

Exercise: Derive equation 2.5 from equation 2.4.

2.3 The Milky Way

2.3.1 Geometry for preparation

Imagine, we look with our radio telescope towards a gas cloud somewhere in the
galaxy. In Fig.2.2 and 2.3 it can be seen that the actual velocity V of a cloud is
at an angle with the line of sight, so we can only measure the projection of the
velocity of the cloud onto the line of sight, Vlos. The observed velocity is usually
referred to as the radial velocity Vr, i.e. the projection of V minus the velocity of
the sun on the line of sight. One obtains from Fig. 2.3

Vr = V cos α − V0 sin c . (2.6)
In the upper triangle you can see that
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Figure 2.3: Geometry of the Galaxy and definition of angles used in tangent point
method.

(90 − l) + 90 + c = 180 ⇒ c = l . (2.7)

The angle α between V and the line of sight can be calculated from the triangle
CMT, here

a + b + 90 = 180 ⇒ b = 90 − a . (2.8)
The path CM forms a right angle with V . If one uses the expression just calculated
for the angle b (not to be confused with the galactic height!), One obtains

b + α = 90 ⇒ α = 90 − b = 90 − (90 − a) = a ⇒ α = a . (2.9)

Thus, equation 2.6 can be rewritten as

Vr = V cos α − V0 sin l . (2.10)

Now α should be replaced by other variables. Looking at the triangles CST and
CMT, we notice that the distance of the galactic centre C from the tangent point
T can be expressed in two ways:

CT = R0 sin l = R cos α . (2.11)
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Substituting cos α from this expression in equation 2.10 one gets

Vr = V
R0

R
sin l − V0 sin l . (2.12)

2.3.2 How does the gas rotate?

To describe the rotation in a disk, so-called rotation curves are used. They indicate
the orbital velocity as a function of the radius, and at this point three different
types of rotation curves can be discussed. These are shown in Fig.2.4.

Solid body rotation: This rotation can be applied, for instance to describe
rotation of a CD which spins at a constant angular velocity Ω = V

R
= const :

V ∝ R . (2.13)

Keplerian rotation: The most prominent example of this is the solar system,
which has a negligible mass compared to the sun. Thus, the center of gravity of
the solar system is very close to the centre of the sun. The centrifugal acceleration
of the planetary orbits is equal to the gravitational acceleration:

V 2

R
= GM

R2 , (2.14)

where M is the total mass of the system and G is the gravitational constant. The
rotation curve is then called Keplerian and the web speeds decrease with increasing
radius:

VKepler(R) =
√

GM

R
. (2.15)

Differential rotation: The rotation curve of a galaxy shows the orbital velocity
as a function of the galactic radius not described as Keplerian rotation. Unlike
a system with a large central mass, most galaxies have more or less uniformly
distributed mass, which of course changes the expression for angular velocity given
above. In particular, flat rotation curves, V (R) are often observed at larger radii.

VGalaxie(R) = const . (2.16)
The angular velocity then goes with Ω propto1/R. The mass, which is closer to
the center, rotates at a higher angular velocity than the mass further out. At large
radii the velocities are significantly greater than in the case of Kepler rotation even
if all visible mass is taken into the account. As mentioned above, this indicates the
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Figure 2.4: Rotational curves of different types of rotation: solid body rotation (top
left), Keplerian rotation (top right), and differential rotation (bottom).

existence of additional “dark” matter at large radii, and represents a strong (but
not the only) argument in favour of “dark” matter existence.
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Figure 2.5: Different velocity components in the observed spectrum at a fixed
position l.

In this experiment we want to use the gas clouds to determine the rotation curve
V (R) in the first quadrant (0 deg ≤ l ≤ 90 deg). Since several gas clouds can
lie along arbitrary line of sight, one usually observes several different spectral
components, i.e. several doppler-shifted lines corresponding to different velocities
as shown in Fig.2.5. For a gas cloud in the tangent point T, the velocity vector V
lies exactly on the line of sight, so the projection of its velocity is largest, and the
cloud has the maximum observed velocity Vrmax relative to us (see 2.3). For T

RT = R0 sin l (2.17)
VT = Vr,max + V0 sin l . (2.18)

By observing at different galactic longitudes l, several values of Vr, max can be
measured for respective tangent points. For each point we can then calculate R
and V , and thus construct a rotation curve.
To summarise, the sequence can be as follows: We have

• H I is observed at different galactic longitudes l in the first quadrant.

• the maximum velocity component Vr, max is measured for every l.
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• assumed that the corresponding gas is at the point of tangency.

• assumed we know R0 and V0.

From this we can determine the rotational curve V (R) of the Milky Way. Exercise:
Where (in terms of l) the method is applicable? Why?

2.3.3 Where is the gas?

So far, we’ve only used the maximum velocity component, assuming it comes
from the tangent point. To determine the location of the H I gas in the galaxy,
all velocity components of the observed spectrum can be used. Indeed, this can
be done once we assume that rotation curve V (R) is known (for example from
the previous section). As in the previous section, we measure Vr at different l in
the Galaxy and assume that we know R0 and V0. Again, equation 2.10 is used.
However, on the basis of the measured rotation curve, we can now say that we know
that the gas in the Milky Way is differentially rotating, that is, V (R) ≃ const = V0,
so that from equation 2.10

Vr = V0 sin l
(

R0

R
− 1

)
(2.19)

and R can be expressed as a function of known variables:

R = R0V0 sin l

V0 sin l + Vr

. (2.20)

Now we can make a map of the Milky Way and plot the positions of the gas clouds
we have discovered, using the measurements of the radial velocity Vr and Equation
2.20 to estimate the distance of the individual clouds from the galactic center. We
also know the direction in which we observed it (the galactic longitude). If now we
go back to Fig.2.3, it becomes clear that:

• If we have observed I or IV quadrants, there are two possible positions of
a cloud for given values of l and R: Closer than the tangle point T (in the
figure with M) or farther away, at the intersection of the inner circle with
the path ST.

• If we have observed in quadrant II or III, the position is univocally deter-
minable.
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This can also be shown mathematically: If one plots the position M of the cloud
with respect to the Sun S in polar coordinates (r, l) with the distance from the sun
r and the galactic longitude l, for the triangle CSM we have

R2 = R2
0 + r2 − 2R0r cos l . (2.21)

This is a quadratic equation for r with two possible solutions, r = r+ and r = r−:

r± = ±
√

R2 − R2
0 sin2 l + R0 cos l , (2.22)

therefore,

• If cos l < 0 (in quadrants II and III), one can show that there is only one
positive solution r+, which is still positive, since R > R0

• In the other two quadrants two positive solutions are possible.

Negative values of r are not physically meaningful. In the case of two positive
solutions for given l, we can observe at slightly different b which is likely to make
the further situated cloud invisible. Alternatively, the solution can be selected
manually on the basis of the overall structure of the Galaxy if it is known at least
approximately.

In real life the situation is a bit more complex. Emission from material located at
different distances is mixed together, so detailed modelling is required to remap
the velocity-longitude to distance longitude space, and thus the map of the Milky
Way in Galaxy. In fact, despite extensive observations in radio and other bands,
even the number of spiral arms of our Galaxy is still uncertain. Neverthless, the
main features shown in Fig. 2.6 have been mapped.
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Figure 2.6: Portrait of the Milky Way in υ − l space. Structures located at different
distances have different velocities, so it is possible to see individual spiral
arms shown in Fig. 1.4 directly in such plot (Image credit: COGAL
survey).
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Exercise: What else (besides the rotation curve) can we say about the Galaxy
using the obtained measurements? Explain the steps to do so.

2.3.4 Estimation of the mass of our Galaxy

Assuming that most of the mass of our galaxy is in a spherical structure around its
centre (in the so-called dark-matter halo), its mass M within a certain radius R
can be calculated. Indeed, the Jeans theorem states that in the case of a symmetric
symmetric distribution, the mass outside of R does not affect the velocity at R, so
we can ignore contribution of the outer parts. In addition, according to another
theorem (also by Jeans), the motion of matter at the radius R, is the same as
if mass was concentrated in one central point if mass distribution is spherically
symmetric. As we discussed in section 4.3.2:

V 2

R
= GM(< R)

R2 , (2.23)

therefore,
M(< R) = V 2R

G
. (2.24)

Exercise: Calculate the mass of the Galaxy within the orbit of the Solar system
and give it in solar masses and kilograms. Compare the value with a literature
value (source!) and explain deviations and assumptions.
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3 Observations with the Tübingen
Radio Telescope

3.1 The telescope

The Tübingen Radio Telescope (Fig.3.1) was designed by Are Elektronik in Sweden
and was funded by the University of Tuebingen throgh student fees and a prize
for pedagogical achievments awarded to Dr. T. Nagel in 2009. The telescope has
a parabolic antenna with 2.3 m diameter, and stands next to the dome building
of the large 80 cm telescope telescope on the Sand. It has an angular resolution
of about 5◦ at the frequency of the 21 cm line of hydrogen (1420 MHz), and is
controlled by the program qradio from a small Ubuntu PC out, which is located
next door in a small telescope dome. The telescope can operate as a bolometer, i.e.
measuring the total power of radio signal coming from the sky, or as a spectrometer.
In the former case the measured signal can be compared with calibration source,
the “noise diode”, situated in the middle of the dish. In the later case, the power
is measured quasi-simultaneously at two frequencies corresponding to spectral line
of interest (“signal”), and background (“reference”), i.e. part of the spectrum
containing no line. In this way, the contribution of the human produced radio
waves, emisison of the sky, and continuum emission of the source itself can be
significantly supressed, and the line amplified. One can select the appropriate mode
from qradio interface.

The telescope is equipped with Alt-Az mount, but one can specify desiring pointing
position using several coordinate systems, including Galactic and Equatorial coordi-
nates expressed either in degrees or hour minutes and seconds (for right assention).
Please see the help of qradio for allowed coordinate formats. Be sure to control
that correct coordinate system and format are used, as otherwise the telescope
will be pointing in wrong direction and measurements will be meaningless! When
planning and conducting the experiment please consider that targets low above
the horizon are harder to observe as the power of radio interference picked by the
antenna increases. Trees and other obstacles also decreas power of the signal and
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are best avoided. Finally, it is important to keep in mind that the control software
is somewhat unstable, so be sure to save your results regularly.

Figure 3.1: The Tuebingen radio telescope
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3.2 Preparation

During the experiment we will observe the Sun and the Milky Way along the
galactic longitude l with b = 0, so in equatorial coordinates it extends according
to Table 3.1. Before starting the experiment please try to answer the question:
which part of the Milky Way can you actually see during the experiment? Which
quadrant? Only this section can be observed with the radio telescope. Which parts
of the observable part of the Milky Way would you observe in the morning and
which later on? Why?

The Sun is obviously observed for most of the day, however, it makes sence to
observe it when it is highest above the horizon. When is that? Please consider also
that position of the Sun changes during the year, so you will need to find a way to
learn where it is located at the time of observations, i.e. its coordinates. Please
use software of your choices to calculate the coordinates of the Sun in advance.

Exercise: What part of the Milky Way is observable on the day of experiment
(give range of l)? Use planetarium program of your choice or online planetarium
such as https://in-the-sky.org/skymap.php.
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Table 3.1: Coordinates of the Milky Way
l RA in ◦ DEC in ◦ l RA in ◦ DEC in ◦

0 266.41 -28.94 155 66.81 48.95
10 271.94 -20.29 160 71.74 45.25
15 274.47 -15.90 165 76.06 41.35
20 276.88 -11.49 170 79.87 37.31
25 279.22 -7.05 175 83.30 33.17
30 281.52 -2.61 180 86.40 28.94
35 283.80 1.84 185 89.27 24.64
40 286.10 6.29 190 91.94 20.29
45 288.43 10.72 195 94.47 15.90
50 290.83 15.14 200 96.88 11.49
55 293.33 19.53 205 99.22 7.05
60 295.98 23.89 210 101.52 2.61
65 298.80 28.20 215 103.80 -1.84
70 301.87 32.44 220 106.10 -6.29
75 305.23 36.61 225 108.43 -10.72
80 308.97 40.66 230 110.83 -15.14
85 313.19 44.59 235 113.33 -19.53
90 318.00 48.33 240 115.98 -23.89
95 323.56 51.84 245 118.80 -28.20

100 330.00 55.05 250 121.87 -32.44
105 337.50 57.86 260 128.97 -40.66
110 346.13 60.16 270 138.00 -48.33
115 355.87 61.82 280 150.00 -55.05
120 6.45 62.73 290 166.13 -60.16
125 17.39 62.80 300 186.45 -62.73
130 28.07 62.03 310 208.07 -62.03
135 37.98 60.50 320 226.81 -58.30
140 46.81 58.30 330 241.12 -52.42
145 54.50 55.57 340 251.74 -45.25
146 55.50 56.57 350 259.87 -37.32
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3.3 Conducting the observations

Restart the Ubuntu PC first (restart required). Start the program qradio on the
Ubuntu PC. First, a window with configuration details appears (Fig. 3.2). These
are fine (i.e. in line with the figure), go ahead with accept. Now you see the actual
graphical user interface (GUI) for the telescope control (see Fig.3.3). Here you can
set various parameters as required for observation. Click on the tab Control:

• in the box Receiver :

– in the box Mode: select switched for Milky Way or signal for Sun
observations, be sure not to confuse!

– in the box Switching: select frequency (if this mode is used)

– in the box Frequency/Gain: Adjust the gain (db * 10) so that both levels
show about 30 % power. The gain should usually be set to about 40-60.
This applies also to Sun observations, although only signal amplification
will need to be adjusted in this case. For Sun observations be sure to
conduct this adjustement when Sun is not in the field of view.

• in the box Telescope the actual position and the commanded position are
displayed. To change a position, first set the desired coordinate system (in
our case it is easiest to use galactic or ecliptic), and then enter the desired
coordinates in the boxes next to it. The Galactic coordinates must be entered
in degrees, whereas for Ecliptic coordinates both degrees and hms format (as
provided, for isntance, by Kstars) are accepted. Be sure to provide coordinates
in correct format and verify that the telescope points in correct direction (i.e.
to the Sun when current Sun coordinates are entered). Keep in mind that
coordinate system selection resets upon restart so you need to set
it to correct value again!

• If you now click on Track, the telescope will move to the required position,
the target coordinates will be displayed in commanded field. To stop the
telescope, click on Stop. Has the telescope reached its target position, the
values in the commanded and actual fields should match. Remember that
these are indicated in Altitude/Azimuth coordinate system, regardless on
which coordinate system was used to specify desired position. After the
telescope reached commanded position wait a bit before it fully settles and
begins tracking.

• To record a spectrum (that is to perform a measurement), first set the
integration time (below right), 10-20 s should be sufficient. Then start
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the integration by pressing Observe button. In the left column a file name
appears (eg B.00001c.fits) once the integration is finished. At this point the
interface screen blinks and the number of recorded spectra in the left panel
increases. Be sure not to click stop before this happens as otherwise result
may not be recorded. To inspect the result, click on the file name, the display
changes from Control to Spectrum (Fig. 3.4). You can choose if the x axis
represents frequency or velocity (assuming zero velocity corresponds to the
observing frequency). You can also restrict the displayed value range. Note
that spectrum will not be displayed for Sun observations as you only measure
intensity!

• To start a new recording, switch back to Control again. Click Stop to stop
tracking, and then enter new coordinates. Drive the telescope to new position
with Track, and once the pointing is settled you can record a new spectrum.

• For Sun observations start with entering current position of the object, and
verify that the telescope indeed points in the correct direction. If the weather
allows, you can check the accuracy of the pointing visually by pointing to
the Sun itself and checking whether the secondary mirror shadow is centered
on the main dish. After that, you have two options on how to proceed with
the experiment:

– conduct scans in ±10◦ interval along DEC with RA fixed to known
Sun position. Please repeat measurement at least twice for each angle,
starting from -10 and going to 10 degree offset, and then back. This
is to get an idea of true uncertainty of measured intensities and flux
variability. Take continuum spectrum at each location and store for
further analysis. Once done, fix DEC to known Sun position and alter
RA to scan along this direction. If you enter coordinates in hms format,
be sure to use correct step size. Keep in mind that 24h correspond to
360◦. Alternatively, you can just convert Sun position to degrees.

– alternatively, you can do a raster scan with 10◦ × 10◦× to 20◦ × 20◦×
size of the region around the Sun (scan along one coordinate, then make
a small step in other and repeat the scan, and so on). That is, to make
a proper image of this region. Here you can balance the size of the
region, resolution, and time it takes to complete the imaging. Of course,
this implies that more measurements have to be taken than in the first
option, but reward is that you can really see the Sun in your picture!
To speed things a bit, you can avoid taking spectra and just read out
intensity values from user interface for each pixel. That’s slightly less
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accurate, but faster to measure and does not require extra analysis steps
afterwards, so including analysis both options are actually comparable.

• For Milky way observations, start the observations with part of the sky which
is closest to setting at the start of experiment (i.e. with altitude of ∼ 15◦ in
the west), and continue along the Galactic plane in eastern direction. As you
traverse the observable part of the Milky Way, note the galactic coordinates
and corresponding file name for each exposure (obviously b is kept fixed
to 0). Alternatively you can re-name the file after each exposure so that
coordinates can be read directly from file name. Save each shot immediately
as a precautionary measure, qradio tends to crash spontaneously, so any
unsaved exposures will be lost.

• It may also be a good idea to take a “background” spectrum to aid identifi-
cation of the spectral lines coming from the gas concentrated in the Galactic
plane. In order to do so, you must point the telescope at |b| > 10◦ for a given
l in addition to the main exposure taken at b = 0. The lines only appearing in
the later but not in the former spectrum, are what you are looking for. You
are done with the measurements please stop tracking and park the telescope
by clicking Reset. Wait until the telescope reaches parking position before
quitting qradio and switching off power of the telescope.
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Figure 3.2: Configuration window for qradio. Adjust to match the figure if there
are any discrepancies
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Figure 3.3: User interface of the qradio control software.
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Figure 3.4: Presentation of the observed spectrum in qradio, in frequency and
velocity spaces
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4 Data analysis

4.1 Software

The recorded data can be analysed with various computer programs, including
SalsaJ, a software of the Hand-on Universe Europe project, which is available on
the EU-HOU website for all operating systems, and simply by can be downloaded
there. SalsaJ is also installed on the computers in the Astro library where you
are suggested to conduct the evaluation of your results. If you have a laptop,
bring it with you, preferable with SalsaJ installed already. This will make it easier
to finish evaluation at home if you run out of time. The operation of SalsaJ is
not complicated, however you need to use “open Radio spectrum” rather than
simply “open” to ensure that the velocity information is read correctly. In addition,
you will need to use a spreadsheet program (i.e. Excel or alternative) to perform
calculations and make plots. Alternatively, you can use software/programming
language of your choice, but in all cases please hand over your code/spreadsheet
together with the protocol, so the calculations are reproducible by the tutor.

4.2 Data reduction and measurement

1. Inspect the data.
SalsaJ can be used for this. Attempt to display the spectrum, so read the appropri-
ate FITS file as a spectrum and display it in the program window. Set the speed
as the unit for the x-axis. Now you should see a spectrum. Some (if not all) of
your spectra will show a relatively sharp peaks, which is not the signal from the
Milky Way but rather terrestrial interference, and can be ignored.

2. Measure the intensities.
For observations of the Sun we are only interested in the observed intensity, not
the spectrum shape. You will notice, however, that the observed spectra are not
flat (as expected), but rather exhibits low and high frequency roll overs. These are
associated with the response of the instrument, and not the sun itself! Furthermore,
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radiointerference (RFI) peaks may be observed. A representative spectrum is shown
in Fig. 4.1. To estimate the intensity, pick a region in the middle of the spectrum
which is free from RFI, and read out several representative values from this band
with SalsaJ. Use the same channel/velocity range for all spectra! For each solar
spectrum note the average of measured intensity values and RA/DEC coordinates
of the pointing expressed in units of degrees. To convert from hms units to degrees
you may note that Earth completes one full roation (360 degrees) in 24 hours.

3. Measure the velocities.
Same procedure can be used to read spectra of the Mikly Way. Here we are
interested, however, in velocities of observed spectral lines. An example of such
spectrum in qradio interface was shown above and is shown in Fig. 4.1 as it appears
in SalsaJ. Note that several velocity components may be present each spectrum.
If that is the case, please read all of them one by one by moving the cursor to
middle points of respective peaks in the spectrum. It’s best to put these directly
into a table with the galactic length of each observation in the first column and the
measured velocity in the second column to keep track of the measurements. Ignore
the sharp peaks mentioned above. If in doubt, compare the spectrum with the
“background” spectrum you took away from the Galactic plane which shall contain
similar features. Examine each spectrum and use the cursor to read the velocities,
zoom if more accurate values are required. Please consider that realistic accuracy
of your measurements is quite low, so it is sufficient to round measured values to
integrer number of kilometers/s.

If a spectrum has several velocity components, each must be measured and assigned
to the same galactic length, for example:

l v in km/s
50 48
50 12
50 25
70 -90
70 -22
70 2
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Figure 4.1: User interface of the SalsaJ program showing examples of spectra
measured from the Milky Way and the Sun.
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4.3 Data analysis

4.3.1 Position of the Sun and angular resolution of the telescope

For scans along RA/DEC directions plot two curves similar to Fig. 4.2. In each
curve you shall be able to see increase of intensity corresponding to position of the
sun. To estimate the respective coordinates, you may fit the peak with a Gaussian
function combined with a constant to account for background using software of
your choice. Please give some details on the procedure you use in the report. The
center location and width of the gaussian will give you respective coordinates and
width of the beam, i.e. angular resolution of the telescope.
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Figure 4.2: Observed intensity from the direction of the Sun as function of declina-
tion (in equatorial coordinate system). The location of the peak gives
the position of the Sun, and its width corresponds to the telescopes
angular resolution.

Alternatively, you may estimate both quantities by eye. Keep in mind that the
width of the peak must be at measured at half of its peak value. To do that, you
need, however, to subtract background intensity first. Estimate it by eye, and
subtract from the observed intensities so that only source emission remains. Plot
it and estimate center position and width at half maximum by eye. In any case,
please indicate estimated or best-fit values in the plot. Compare results with known
position of the sun at the time of observation, and with theoretical estimate of the
telescope resolution. The report shall thus include plots for both scans similar to
Fig. 4.2, estimated sun position, and offset from the true position.
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4.3.2 Rotation curve

Now we want to construct a rotation curve from the individual data points. In
chapter 2 it was shown that for gas observed at the tangential point, the distance
from the centre of the Milky Way can be univocally determined. Likewise, the
speed of the corresponding cloud can be calculated. In this section, only the highest
velocity from each spectrum is of interest, since this corresponds to the gas cloud
at the tangential point. Keep in mind that the tangential point method only is
applicable for certain part of the Milky Way (which?). To create the rotation curve
using the OpenOffice Spreadsheet software, follow the steps below:

• Create one column each for l and Vr,max and enter the corresponding values.

• Since we need V0 and R0, it is useful to define them as constants by putting
the value of the constant (in kpc km/s) in any field. Then go to Insert ⇒
Names ⇒ Define. In the box that opens, the name (ie R0 or V0) can be
entered. Click in the box below and then on the cell in the spreadsheet with
the appropriate value. The field now contains the name of the cell. Click Add
and repeat with the second constant. Now the values can be used directly
via their names in formulas.

• Now let’s use the equations 2.17 and 2.18 to calculate R and V . Add a new
column by typing the formula in the top box:
= R0 * SIN (X1 * PI () / 180). Here we convert degrees to Radian. X1
must be the name of the topmost cell of the l column. Complete the calculation
for all rows by clicking on the top cell and dragging down the bottom left
corner. Now we have calculated all values of R at the tangent point for each
l.[1ex]

• In the next column V should be calculated, something like this:
=X2+V0*SIN(X1*PI()/180)

(see equation 2.18). Again, this column must be completed for all values of l.

We would like now to plot the results:

• Mark the entire third and fourth column (i.e. containing the variables you’d
like to plot). Go to Insert ⇒ Chart, and select xy − chart (Scatter), then
click create and the graph will be generated. You should see a nearly constant
rotation curve.

• By right-clicking on the diagram, the axes can now be labeled.
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• save the diagram as a pdf-file: select it and go to File ⇒ Export as PDF ⇒
Range: Selection ⇒ Export.

4.3.3 Map of the Milky Way

To construct a map of the Milky Way, we need all the measured speeds. Here we
proceed as described in section 2.3.3.

• Go to the table where you stored all measured velocities for all Galactic
longitudes.

• Calculate the distance from the centre of the galaxy R to equation 2.20
(Caution: The result from section 4.3.2 cannot be reused!). Use the functions
SIN () and PI ().

• Calculate r, i.e. distance from a molecular cloud to the Sun using equation
2.22. As discussed above, you can have two solutions here r±, it’s easiest to
store them in two separate columns. The following functions can be used.

– POWER(<cell>,Exponent)

– SIN()

– COS()

– PI()

– SQRT()

As already mentioned in section 2.3.3, there may be two positive solutions
(in the first and fourth quadrants). A follow-up observation in the course of
this experiment is not possible for reasons of time, so consider using both
data points, and once the map is ready you should try to exclude one of
the solutions (please provide justification in the protocol!). In case of two
negative values for r pm the data point can be ignored ,

• The next step is to calculate the xy coordinates of the data points to produce
the map. The following relationship should be known:

x = r cos θ (4.1)
y = r sin θ (4.2)
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Figure 4.3: Galactic coordinates are polar coordinates, so can be converted to
cartesian coordinates as usual. The important point is that the origin
of the coordinate system is at the position of the Sun, and l = 0,b = 0
correspond to Galactic centre.

To use these for coordinate conversion, take a look at 4.3. It shall be clear
then that θ = 270◦ + l bzw. θ = l − 90◦. With the help of the equations 4.1
and 4.2 the coordinates can now be computed, adding R0 to the y-coordinate
if the origin (0, 0) should be in the galactic centre.

• Finally, the calculated coordinates can be displayed in a plot (see previous
section on how to produce one). You shall be able to see the spiral structure
of the Galaxy now. Please compare you’re results with those pictured in
Fig. 2.6. It makes sense to illustrate the position of the Sun and the Milky
Way radius (source!).
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4.4 Questions

Exercise: What kind of radiation is emitted by the galactic center in the form of
radio waves and what is its origin? What’s the origin of radio emission from the
Sun?

Exercise: Calculate the expected angular resolution of 2.3 m radio telescope
operating at GHz frequencies and compare it with the angular size of the Sun. Is
the assumption mentioned above justified?

Exercise: Why do the two coordinates l and b suffice to describe the (three-
dimensional) Milky Way? Is it always the case?

Exercise: what kind of observable signal does neutral hydrogen produce? Why is
it easy to observe? Can you think of other tracers which can be used for similar
purposes?

Exercise: Why equatorial coordinate system is preferred for this excercise? How
many points would you need to accomplish the excercise (for a single scan)? What
would be corresponding step size expressed in degrees, and hours, minutes, seconds
(for right assention)?.

Exercise: Derive equation 2.5 from equation 2.4.

Exercise: Where (in terms of l) the tangent point method is applicable? Why?

Exercise: What else (besides the rotation curve) can we say about the Galaxy
using the obtained measurements? Explain the steps to do so.

Exercise: Calculate the mass of the Galaxy within the orbit of the Solar system
and give it in solar masses and kilograms. Compare the value with a literature
value (source!) and explain deviations and assumptions.

Exercise: What part of the Milky Way is observable on the day of experiment
(give range of l)? Use planetarium program of your choice or online planetarium
such as https://in-the-sky.org/skymap.php.
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Links

• Website of Tuebingen radiotelescope: http://www.physik.uni-tuebingen.
de/institute/astronomie-astrophysik/institut/astronomie/80cm-teleskop/
radioteleskop.html

• Website of F-Praktikums http://www.physik.uni-tuebingen.de/institute/
astronomie-astrophysik/institut/astronomie/studium/f-praktikum.html

• Official web-site of the european project (EU-HOU) Hand-On Universe:
http://www.euhou.net/

• Web-site of SALSA radio telescope: http://brage.oso.chalmers.se/salsa/

• Official OpenOffice Website: http://www.openoffice.org/
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Literature

• The incorrect rotation curve of the Milky Way: L. Chemin, F. Renaud, C.
Soubiran: https://arxiv.org/abs/1504.01507

• The new cosmos, A. Uns"old, B. Baschek, 7. Edition

• Chapter 5.2 Radio telescopes

• Chapter 10.2 Neutral interstellar medium, Focus on 21 cm line

• Chapter 11 Origin and dynamics of the Milky Way

• Fundamental Astronomy, H. Karttunen, themes from the list above

• other introductionary books covering the themes above
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